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introduction .1
iBoard allows you to create stylish still image 
presentations, easily and quickly. At the touch of a 
button you can add or remove frames, add images, 
change the size and the orientation of you 
presentation. iBoard does all the layout work for 
you, recalculating the frame sizes so they fit on the 
page neatly.

iBoard was developed with Movie Creatives in 
mind.So the frames default to televison screen 
ratios, either normal TV, or 4 x 3 or widescreen TV 
size or 16 x 9. But iBoard will display any image in 
its native ratio, so there’s no reason why you 
couldn’t put together a mood board of images of 
different sizes and shapes.

Each frame has its own text area below it, and you 
have complete control over the font, style and 
colour of the text. You can hide it as well if you 
want.
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overview .2
• Add and remove frames from your story board 

quickly
• Add images to your frames easily
• Add a series of pictures with the Add Folder 

function
• Change the document size, resolution and 

orientation easily and let iBoard rejiggle the 
layout.

• Import images from QuickTime movies
• Set the style of all text items.
• Set the background colour or give the 

storyboard an image as a background
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menus .3

•file menu

• New Board
Opens a new iBoard document.

• Open Board
Opens a previously saved iBoard document.

• Close Window
Closes the foremost iBoard document. You will be asked to 
save any changes.

• Save 
Save the current iBoard document for later use.
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• Save As...
Save the current iBoard document as a differently named 
document.

• Export
You can export your picture to many picutre formats including 
PICT, JPEG, TIFF and BMP.

• Page Setup.
Choose the printer you want to print to. Remember to select 
the same size document as you are working on

• Print
Prints the current document. In OSX you can choose to save 
the document as a PDF from the print  dialog box.

• Quit (not shown)
Quit iBoard. You will be prompted to save your work.

•edit menu
• Undo

Undo the last action. You can select the number of undos you 
want from the Preferences.
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• Redo
Redo the last undo.

• Cut/Copy/Paste
Copy text or whole frames

• Properties

• Show
Brings up the Document Properties Window. From here you 
can set global document settings like the background colour or 
image and the margin values. This is where you set all the 
header and footer text items.

• Copy To Preferences
This copies the values in the Document Properties Window to 
the Preferences so that they are available for any new 
document you create. 
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• Copy From Preferences 
This copies the values from the preferences to the current 
document. Its a fast way of changing all the values in one go.

• Toggle Orientation
You can toggle the document orientation between landscape 
and portrait. iBoard recalculates all the frame sizes and 
positions to maximise the space available.

•frame menu

• Add/Remove Frame 
Add an empty to your layout. iBoard automagically realigns all 
the frames and text. Remove frame removes the selectd frame.

• Add/Remove Image.
Add  or remove an image to the selected frame. The frame is 
displayed in the ratio that the frame is set to. You can select 
frames  to be 4 x 3, 16 x 9 or to display in the ratio of the 
image.

• Add Folder
Add a series of images from the selected folder. The images 
are added to the selected frame to the end of the layout. New 
frames are not added if the are more images in the folder than 
frames.
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• Add Image From Movie
Brings up the Import Movie window. You can select individual
frames or a series of images from a selected QuickTime movie. 
See below for more information.

• Next / Previous Frame
Changes the selected frame to the next or previous frame.

• Lock/Unlock Frame
Toggles the lock status on the selected frame.

• Lock/Unlock All
Locks or unlocks all the frames in thelayout regardless of their 
lock status.

• Toggle Locks
Toggles the lock status of all frames in the layout.

• Show Properties
Show the Frame Properties Window. Settings made in this 
window effect all frames in the layout. Locking a frame will 
prevent changes being made to it. See below for more 
information.

• Show Inspector
Shows the Frame Inspector Window for the selected frame.
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•view menu

• Fit In Window
Fits the document into the current window size.

• Show Pixels
Shows the image at its native size.

• Zoom In/Out
Increases and decreases the display size of the image.

• Preferences
Select a default set of values for your Company’s information. 
New iBoard documents will use these settings  
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easy start .4
Creating professional presentations with iBoard is easy. 

•Simply choose New from the File menu. An iBoard document will 
be created for you with four empty frames.  

•Now open the Documents Propertis window, from here you can 
alter the Orientation, Size and resolution of you document. The new 
document defaults to a landscape A3, 72 dpi document. We shall 
leave it at this for now. You can edit the margin sizes here now if 
you wish also.

•Now we shall set an image as a background picture. Press the Set 
Image button and choose an image from the file selector diaog box. 
The image will appear in the image display area. We can now 
set clearly we want this image to appear by moving the Opacity 
slider. A value nearer zero will make the image more transparent. 
The image display will update to show you how it will look in the 
document. we can give the whole thing a colour wash by selected a 
Background Colour by clicking on the coloured square. You will see 
that by selecting a background colour and changing the opacity of 
the imported background image you can give the background a 
colour wash effect. The colour of the text in the header and the 
footer defaults to black, but you can change the colour of all the 
elements quickly and in one go by clicking on the Text Colour 
coloured box. You can of course change the colour of each element 
individually by clicking on the Options button. 
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•You can now enter the details in for your board. On this tab panel 
is the board info details. Press the Headers tab panel to reveal 
editFields to enter in your company name and address information. 
iBoard will postion this information depending on its length. Size, text 
font, colour and style can all be set for each of these elements by 
clicking on the Options button, and making selections from the Text 
Style Window.

• Press Done and you will see the changes you have made in the 
document window.

• Now we will add a series of images to our empty frames. First click 
on the first frame. You see that it highlighted in red to show that it is 
selected. Now select Add Folder from the Frame menu or click on 
the Add Folder Toolbar icon. A dialog box will appear that allows 
you to select a folder. Press choose. iBoard now opens the images 
stored in your selected folder and puts them into all of the frames in 
turn.

•I’ve now decided that I want to change the second image. Click on 
the second frame so that it is highlighted red. Now choose Add 
Image from the Frame menu, or click on the Add Image Toolbar icon. 
Navigate and select an image from the file selector dialog box. The 
image will appear in the frame.

• One of the things that isn’t right about our board is that the 
images look squashed and pinched. This is because the frames 
default to displaying in 16x9 mode. We can make the images look 
right by showing the Frame Properties Window.
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•Open the Frame Properties Window by choosing Properties from 
the Frame menu, or by clicking on the Frame Properties Toolbar icon. 
Here we choose Picture Aspect from the frame ratio popup menu. 
Thats it for now from this window, but it’s worth spending some time 
playing with the other values in this window. However remember 
that any changes made from this window will effect all the frames. If 
you want to change things for a single frame you must show the 
inspector for that frame. Simply click on the frame you want to edit 
and select Show Inspector from the Frame menu. 

• You can lock a frame by selecting Lock Frame from the Frame 
menu. Locking a frame will stop any changes you make from the 
Frame Properties window.

• You can now export your finished frame by choosing Export 
Picture from the File Menu. Or you can chhose to save as PDF from 
the Print dialog box. Be sure to set your Page set up details before 
you print.
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document properties .5
window

From this window you can control several document settings. The 
orientation, the size and the resolutioun can all be modifed from 
here. You can select a background colour or an image for the board, 
and you can change the opacity of the background image, to give 
washed out colour wash effects. It is from this window that all the 
text that appears in the header and the footer is set. You have 
complete control over the font, the style and the colour of the text. 
You can also hide it if its not necessary for your board.

•Document

• Orientation
How annoying it would be if you decided in the middle of 
making a storyboard that it would be better presented as a 
portrait document. Well iBoard makes it a simple thing to 
change. You can either bring the Document Properties 
Window and select the orientation you would like from the 
popup menu, or you can select to toggle the current 
orientation via the menu command, Edit => Toggle Orientation.
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• Resolution
You can up rez you document when you have finished the 
layout and text. A higher rez document will be more RAM 
hungry and can slow the application down. A good plan is to 
start your layout at 72 dpi and then only up resz it when you 
have finished. Although if your images are a good size 
origianlly and you are printing to a post script printer then you 
will get very good results at 72 dpi. You might want to select 
the higher resolutuion 300 dpi if you are to save you 
document as a PDF or as a JPEG file.
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• Size

Currently you can select between A3 or A4 size.

• Margins
You can select the size of the top, bottom, left and right 
margins from here. You can tweak a layout by changing the 
margin settgings. Remember though different printers have 
different printable areas, and settings the margins too small 
with some printers will result in clipping of the printed image. It 
is often a good idea to do a test black and white print before 
committing to the full colour version.
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• Set Image
You can select an image to display on the backgound of the 
display. This will appear behind the frames. Currently the 
image is drawn into the ratio of the document so some 
stretching or squeezing may occur.

• Opacity
Here you can change the opacity of the background image. 
Setting the opacity to a low number will make it look faint and 
washed out. Combine this with a background colour and you 
can give the background image a colour wash.

• Background Colour
From here you can select a colour, other than the default 
white, for the background. Just click on the coloured box to 
open the Colour Selector Window.

• Set Text Colour
Here you can choose a colour for all the text elements to 
display in. This is a global feature and it will override any 
settings currently in place the text elements.

• Board Info
Here you can title the storyboard, write in the client’s details, 
and date it. The check boxes to the right allow you to hide the 
text so that it doesn’t appear on the board.
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•Headers

• Company text
You can enter the name of your company here

• Company Info
You can enter addresses and telephone numbers here
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• Footer
You can add additional information here. In this example we 

have added a copyright warning.

• Copy From/To Preferences
You can copy the values stored in the Preferences into the 
Document Properties Window, they will then appear in your 
board. Its a quick an easy way to change the board details in 
one go. And it works the other way. You can copy the values 
stored in a board into the Preferences. Now these details will 
be be abvailable by default to any new board you create. the 
chapter on menus for a description of this feature.

• Text Style Window
You can control the style, font and colour of all text in your 
board. You do this by way of the Text Style Window. This is 
opened by pressing the Option button next to the text you 
want to modifiy.
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You select the font you want the text to appear in via the 
popup menu. This menu displays all the current fonts in your 
font folder. 

Selecting the check boxes will toggle the Bold, Underline and 
Italic qualities of the text. 

And you can choose a text colour via the colour selector box. 
Just click on the coloured box to bring up the colour selector 
window. 
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frame properties .6
window

From this window you control how the frames look. You can 
modify their ratio, the border colour and thickness, the style 
and colour of the sub-text, and whether it is visible or not. See 
below for the complete list of modifications that can be made. It 
is important to know however that any changes made from this 
window will effect all frames within the document, unless a 
frame is locked. So changing the border colour to a lurid pink 
will make all the frames look like this. If you want to edit the 
frames individually you will need to open the Frame Inspector. 
See chapter 7 for details.

• Number of frames
Change the current number of frames that appear in yuor 
document. iBoard will automagically readjust the sizes and 
layout to make the frames fit neatly into the space available. 
Allowing for the margins, the header and the footer.

• Frame Ratio
Change the ratio of the frames. As iBoard was developed for 
presenting TV commercial ideas, the frame ratio defaults to 
16 x 9, which is the ratio for widescreen TV. You can also 
select 4 x 3 which is the older TV ratio still supported by some 
countries. Selecting either of these will modify the frame ratio 
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of all the frames in the board. Images displayed in these frames 
may appear stretched or squashed if they did not originate in 
this ratio.

• Border Size
This will modify the thicknessof the border aruond the frames. 
Setting the value to zero will result in a borderless frame. This 
is the only value that isn’t scaled according to the resolution. 
So if you change the resolution from 72 to 300 dpi the frame 
borders will suddenly appear much thinner. You will have to 
change them manually. This is so you can get hairline border 
thicknesses in higher resolution documents.

• Border Colour
Click on the colouted squre to bring up the Colour Selector 
Window. This will set the colour of the frame border for all the 
frames in the document.

• Fit On Page
This feature is on by default in this version of iBoard, and 
cannot be turned off. This ensures that all the frames fit onto 
one page. Multiple page documents will happen in a future 
version of iBoard.

• Number Of Frames Per Row
From this popup you can set how many frames will strectch 
along a row. This can also be set up at any time by pressing 
the number keys on the keyboard. If you set a number thatis 
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higher than the number of frames you have, the frames will be 
scaled as if you did have extra frames there. There is a known 
bug here where the frames will sometimes draw out of the 
frame area. But hey this is version 1, what do you expect?

• Include text
If this is unchecked none of the text below the frames will 
show. Also it wont be used to calculate how big to tdraw the 
frames. This will result in bigger frames closer together.

• Text Visible
This will hide the frame texts. This will effect all the texts 
globally no matter how they are set indiviually.

• Vision Header/Sound Header
Each frame has two text areas where you can display text. 
Commonly these are to describe whats happening in the 
picture and whats happening in the soundtrack at this point. 
You are of course free to use them however you want. You 
can give a title to both of these text areas. This is a global 
setting. If you don’t want any heading then just remove the 
title completely.

• Horizontal Frame Space
From this slider you can control how closely spaced the frames 
are in a row. They are by default drawn with a 50% spacing 
value. Reducing the percentage amount will move them closer 
together. A value of 0% will draw them with no gaps between 
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them. A value of 100% will draw with the maximum gap 
between each frame. The actual gap size will depend on the 
size of the frames, which of course is dependant on the 
number of frames there are in a row.

• Vertical Frame Space
This setting controls the spacing between frames vertically. 
Again a value nearing 0% will draw them closer together, and 
a value nearing 100% will draw them further apart.
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frame inspector .7
window

From this window you can set the properties of the frames 
individually. So each frame can have its own border width and 
colour, or its own vision text size and font. Each frame can 
obviously have its own image, but it can have its own ratio 
also.

It is important to know that values set in this window alter only 
the selected frame. If subsequently the Frame Properties 
Window is opened and changes are made this will effect all 
the frames as a whole. And this will overi ride any settings you 
may have made individually to a frame.  A good practice to get 
into is to try to put all your global modifications into place first, 
and then make individual changes. Back in the real world this is 
of course not always possible, so one way to avoid this is to 
lock a frame before making any global changes. Locked frames 
are left intact.

• Vision text
This is where you alter the text for the uppermost frame text. 
You can alter its style , font and colour by pressing the Options 
button and making choices from the Text Style Window. You 
can also select to Include the text or to make it visible or not. 
This works in exactly the same way as from the Frame 
Properties Window, except that it operates only on the 
selected frame. The setting from the Frame Properties Window 
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takes precedence, such that if the text is marked as Invisible 
from that Window then it will not be visible no matter how it is 
checked in this window. Of course it is marked as Visible in the 
global frame window then it will behave as per your selection 
in this window.

• Sound text
This is the same as above but applies text to the lowermost 

frame text.

• Border Size
Alter the frame border size here. Chnages made here effect 
the selected frame only. This popup menu defaults to ‘No 
Change’. If left to this setting these values are not changed 
when you press Done. This is a handy feature if some of your 
frames are unlocked.

• Border Colour
Click on the coloured box to open the Colour Selector 
Window. The colour of the selected frame border can now be 
altered.

• Frame Ratio
You can alter the ratio of the selected frame from here. You 
can chose 4x3, 16x9 or have the frame reswize itself 
according to the ratio of the image it is displaying. A frame will 
not remember that it is set to display a picture in its native ratio. 
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Thus if you change an image in a frame that was set to resize 
itself to its image’s ratio it will show the new image in the 
orginal format. You will have to reselect the frame and reselect 
the Picture Ratio value from this popup. You can of course set 
this value globally from the Frame Properties Window. This 
popup menu again defaults to No Change. Thus not effecting 
any unlocked frames in your display.

• Frame Lock
You can lock and unlock the current frame from here. You will 
notice that if you lock the frame all of the above controls 
become un-enabled, and you are unable to edit any of the 
values. Simply unlock the frame to re-enable them.
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advanced features .8

• Import Movie Window

Choose the Import Movie Window by clicking on the Import 

Movie Toolbar icon. You can drag a quicktime movie to the 
window or press the Import Movie button. Choose a Quicktime 
Movie from the file selector dialog.  You can play the movie by 
hitting the play button on the controller below the movie or use 
the slider to show the frame you want to import. When you 
select to import a frame from a movie iBoard creates a  PICT 
image of the frame and saves it to disc. But before you can 
import any frames you have to tell iBoard where you would 
like it to saves these images. Once you have selected a 
destination the Import and Sequence buttons become enabled, 
allowing you to imprt the current frame of the quicktime movie 
to your board. iBoard will start to place the frame at the 
currently hightlight frame in your board. It will overwrite any 
image that is currently displayed in that frame. If it runs out of 
frames it will automatically create a new frame to put it in. If 
you have not made a frame selection before you import, 
iBoard assumes you want to add frames from the end.

You can also set iBoard to import a number of frames per 
second from you movie. when you set the number of images 
per second editfield, the Import Sequence Button will become 
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enabled and it will tell you how many frames it’s going to 
create. 

Those of you paying attention will have realised that using the 
Movie Import Window is a quick and easy way of creating still 
images from movies. As iBoard saves the images to disc you 
can then use these in any image manipulation program of your 
choosing. And then of course you can reimport them into 
iBoard to show off your talents.
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registration .9

If you decide you’d like to buy iBoard go to the muteAnt Online 
Store and purchase it from there. Once you have a registration 
number you can make a demo version a fully working version by 
bringing up the about box. Then click on the Register iBoard button. 
Be sure also to register your software with muteAnt via our web site.
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system requirements  .10
•You will need a Macintosh running System 8.6 or above. 
•You will need at least 25 Meg of Ram and 4 meg of Hard drive 
   space for the application.  
•You will also need QuickTime version 4.0 at least.

iBoard uses QuickTime to open graphics files. So it can support any 
file format that QuickTime can handle. Which is pretty much most of 
them.

Please feel free to contact muteAnt to report bugs or to offer 
suggestions on features you’d like to see in future releases.
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